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Glossary

Term Definition

Alert Combination of physiological (clinical) and technical alarm
conditions that generate alert notifications.

Biosensor Single-use medical wearable device that acquires and
wirelessly transmits patient's physiological signals to the
paired UbiqVue™ Patient Relay App or MPR device.

Biosensor ID A five character alphanumerical code (unique identifier)
printed on the Biosensor and Biosensor packaging.

Central Server Manages the decryption, uploading and storage of Biosensor
data from multiple authenticated relay devices. Allows
access to derived parameter and Biosensor data using the
UbiqVue™ Active Monitoring Portal.

Clinical Facility Organization that provides healthcare services and utilizes
monitoring service e.g. Hospital or Medical Facility.

Clinical Facility Administrator
(CFA)

Multiple functions associated with the overall set up and
configuration of Active Monitoring Portal for the clinical
facility.

Clinician

Denotes Clinician role - can assign new patients to any
location or medical group (A clinician can assign patients
only to those groups that are assigned to the Clinician.)

Physician

Denotes Physician role - can set/edit default alert limits for
any assigned patients, view data and acknowledge alerts of
multiple assigned patients or patient groups.

Supervisory Clinician
Denotes Supervisory Clinician (SC) role - SC can set/edit
default alarms for specific groups of patients, assign patients
or patient groups to the user with Clinician or Physician role,
and generate reports and view trends for discharged
patients. View all patients or patient groups in the clinical
facility, acknowledge alerts for all patients in the clinical
facility using the Active Monitoring Portal.

Administrator (CFA )
Denotes Administrator (CFA) role - Multiple functions
associated with the overall set up and configuration of Active
Monitoring Portal. For example, create assign roles
(Supervisory Clinician (SC) /Clinician/Physician/Additional
Clinical Facility Admin) for new users, reset users password,
select patient identification method for the facility (MRN or
Patient ID), create location/medical groups, configure alert
default for the entire clinical facility.

Edit
Denotes additional edit functionality for SC / Clinician / Phys-
ician roles.



Term Definition

Referral Physician External or referral healthcare Physician who is not a user
within the clinical facility and is provided with access to view
specific patient data in the Active Monitoring Portal.

Monitoring Dashboard Multi-Patient monitoring window displays continuous
physiological parameters, waveforms and alert status of
assigned patients to authorized clinical personnel for near-
real time active monitoring.

Multi-Patient Relay (MPR) Multi-Patient Relay network transmits data from multiple
Biosensors via hardware devices (e.g. wireless access
points, computer) to the UbiqVue™ Central Server.

Single Patient Relay (SPR) Relay device is used for the transmission of a patient's
Biosensor data to the UbiqVue™ Central Server.

Service Provider Administrator
(SPA)

The highest level user that manages administration of
multiple clinical facilities and hospital groups.

Relay Bridge The Relay Bridge provides communication between the Bio-
sensor(s) and the Multi-Patient Relay (MPR) instead of a
standard access point, when the Multi-Patient Relay Soft-
ware is hosted in the cloud. It helps in reducing the infra-
structure requirements, thereby facilitating easy deployment
and increased portability.

BLE Gateway The Bluetooth Gateway communicates with multiple third-
party devices and transfers the data to the Multi- Patient
Relay without buffering.

UbiqVue™ Active Monitoring
Portal

Web-based application provides clinical staff remote access,
via the in-built Monitoring Dashboard, to the patient's near
real-time physiological data (Biosensor and derived),
demographics, trends and alert status.
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1 Safety information

1.1 Intended use and indications for use
The UbiqVue™ 1AXWireless Patient Monitoring System is a wireless remote monitoring
system intended for use by healthcare professionals for the continuous collection of
physiological data at home and in healthcare settings. This shall include
Electrocardiography (2-channel ECG), Heart Rate, Respiration Rate, Skin Temperature
and Posture. Data is transmitted wirelessly from the UbiqVue™ 1AXWearable Biosensor
and 3rd party device (for Blood Pressure and SpO2) to the remote central server for
display, storage, and analysis.

The UbiqVue™ 1AXWireless Patient Monitoring System is intended for non-critical, adult
population, who are 18 years of age or older.

The UbiqVue™ 1AXWireless Patient Monitoring System shall include the ability to notify
healthcare professionals when physiological parameters fall outside the set limits and to
display multiple patient's physiological data for Remote Active monitoring.

Notice
Regulatory cleared 3rd-party devices(BP/SpO2) may be integrated to the
UbiqVue Active monitoring portal.

1.2 Contraindications
• The Biosensor is not intended for use on critical care patients.
• The Biosensor is not intended for use on patients with any active implantable

devices, such as defibrillators or pacemakers.

1 Safety information
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1.3 Warnings

Warning
• DO NOT use the Biosensor if the patient has known allergic reaction

to adhesives or electrode hydrogels.
• DO NOT use the Biosensor if the patient has inflamed, irritated or

broken skin in the Biosensor placement area.
• Remove the Biosensor if skin irritation such as severe redness, itching

or allergic symptoms develop; and seek medical attention if an allergic
reaction persists.

• DO NOT allow the patient to wear the Biosensor for more than the
prescribed hours.

• Remove theBiosensor immediately if the patient reports of
uncomfortably warm skin or experiences a burning sensation.

• The Biosensor should not be used as an apnea monitor as it has not
been validated for use in pediatric population.

1 Safety information



1.4 Precautions

Caution
• Excessive motion or activity may adversely affect the Biosensor

performance and adhesion.
• Press down the Biosensor edges and upper area with fingers at least

twice a day, to maintain adhesion.
• Avoid sleeping on stomach, as this may interfere with the Biosensor

performance.
• DO NOT use the Biosensor if the package has been opened, appears

damaged or has expired.
• Avoid use of Biosensor near (< 2 meters) from any interfering wireless

devices such as gaming devices, wireless cameras or microwave
ovens.

• Avoid use of Biosensor near any RF emitting devices such as RFID,
electro-magnetic anti-theft devices and metal detectors as this could
affect communication between the Biosensor and the relay device.

• If the Biosesnsor LED flashes fast (green) (two flashes for every
second), ensure the patient is within 5 meters radius of the Relay
device.

• The Biosensor contains a battery. Dispose theBiosensor in
accordance with the local laws, care facility laws or hospital laws for
non-hazardous electronic waste.

• DO NOT use any skin barrier agents prior to Biosensor application, as
it may cause skin irritation/injury due to a reaction between the barrier
agent and the hydrogel electrodes.

• DO NOT immerse the Biosensor in water.
• Keep showers short with the back to the flow of water. Gently pat dry

with a towel and minimize activity until the Biosensor is fully dry.
• DO NOT use creams or soap near the Biosensor.
• If the Biosensor becomes soiled with blood, and/or bodily

fluids/matter, dispose in accordance with the local laws, care facility
laws or hospital laws for bio-hazardous waste.

• DO NOT wear or use the Biosensor during a magnetic resonance
imaging (MRI) procedure or in a location where it can be exposed to
strong electromagnetic forces.

• DO NOT run any other application on the device when the procedure
is ongoing.

1 Safety information
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• DO NOT reuse the Biosensor, it is for single use only.
• Keep the Biosensor out of reach of children and pets.
• The Biosensor should remain within the operating distance of the

relaydevice (< 5 meters) for uninterrupted viewing.
• The relay device utilizes a mobile data network (3G or higher) to

operate. Before travel, it may be required to enable data roaming and
obtain an international adapter for charging the relay device.

• To ensure continuous streaming of data, the relay device should be
charged every 12 hours or whenever there is a low battery indication.

• Setting alert thresholds to extreme values may reduce the alert
system efficiency.

• All hardware equipment, for example relay devices,, routers,
computer, switches etc. shall comply with the applicable IEC or ISO
standards.

• Maintain a minimum distance of 5 meters radius between the relay
device and the Biosensor.

1.5 Cybersecurity controls

Notice
• To protect against unauthorized use and cybersecurity threats, enable

all access control systems on mobile devices, password protection
and/or Biometric control.

• Ensure the relay device has firewall protection to avoid virus/malware
attack.

• Keep the Android software version up-to-date as updates enhance
existing features, patch security flaws, add new security features, fix
bug issues and improve performance for devices.

• Limit access to essential personnel tasked with maintaining and
operating the Relay device.

• Refrain from using the Single Patient Relay for Unintended activities.

1 Safety information



2 UbiqVue™ Product description

2.1 UbiqVue™ 1AX Wireless Patient Monitoring System
(UX1550)
The system contains the following components:

1AXWearable Biosensor
(UB1550)

Acquires two channels of ECG signals, TTI respiration
signals, skin temperature, posture data and transmits to
Single Patient Relay (SPR) or Multi Patient Relay (MPR)
device.

Single Patient Relay (SPR)
Software (UA2550 R)

A compatible relay device which receives and relays signals
from the paired Biosensor to the Central Server for
processing.

Multi-Patient Relay (MPR)
Software (UA2550-MR)

Installed on compatible computer. Receives and relays
signals from multiple Biosensors to the Central Server for
further processing.

Relay Bridge (UA2550-RB) The Relay Bridge provides communication between the Bio-
sensor(s) and the Multi-Patient Relay (MPR) instead of a
standard access point, when the Multi-Patient Relay Soft-
ware is hosted in the cloud.

UbiqVue™ BLE Gateway
(UA2550-BG)

The Bluetooth Gateway communicates with multiple third-
party devices and transfers the data to the Multi-Patient
Relay without buffering.

UbiqVue™
Central Server Software
(UA2550-S)

Receives data from multiple Biosensors simultaneously.
Derives HR, RR, skin temperature, posture information.
Stores data securely for access by Active Monitoring Portal.

Active Monitoring Portal
(UA2550-C)

Web-based interface used to access and manage patient
physiological and alert data.

2.2 UbiqVue™ 1AX Wearable Biosensor
The Biosensor incorporates the LifeSignals proprietary semiconductor chip (IC),
LC1100, a fully integrated sensor and wireless system supporting WLAN (802.11b)
wireless communications.

The Biosensor acquires two channels of ECG signals, TTI respiration signals (one of the
inputs for deriving respiration rate), skin temperature (measured using thermistor),
posture data (detected by accelerometer), pre-processes and wirelessly transmits the
signals to a paired Single Patient Relay (SPR) or Multi-Patient Relay (MPR) device or
other receiver systems. When the SPR or the MPR devices are available within the

2 UbiqVue™ Product description
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wireless range, acquired data is immediately and continuously transmitted to the SPR or
MPR devices.

If the SPR or MPR devices are not available or if there is any interruption in the
communication between the SPR or the MPR devices and the Biosensor, data will be
temporarily buffered locally in the Biosensor until the wireless connection is re-
established.

1 Right upper electrode.

2 Left upper electrode.

3 Right lower electrode.

4 Left lower electrode.

Figure 1 - UbiqVue™ 1AXWearable Biosensor

UB1550

Channel 1: Right Upper electrode – Left Lower electrode

Channel 2: Right Upper electrode - Right Lower electrode

The Biosensor uses standard WLAN (802.11b) secured (AES) communication protocol
for wireless data transmission to the mobile phone or tablet.

The Biosensor is a battery-operated device, and the Biosensor battery life may vary
depending upon the storage temperature, WLAN environment and the parameter
settings selected.

2.3 UbiqVue™ Single Patient Relay (SPR)
The SPR is a relay device that receives data from a single Biosensor and transfers it to
the Central Server for display, storage and analysis. and performs the following
functions:

• Manages secured wireless communication (WLAN 802.11b) between the SPR and
the Biosensor.

• Facilitates Biosensor placement if required.

2 UbiqVue™ Product description



• Provides user interface for entering the Biosensor and patient information and for
pairing and establishing the connection with the Biosensor.

• Provides user interface for patient to record activities, symptoms and manual entries
(SpO2, Blood Pressure readings).

• Provides user interface to stop patient monitoring session, replace the Biosensor
and view monitoring summary.

• Receives and encrypts physiological signals from the Biosensor and transmits
the data to the central server as quickly as possible.

• Manages encrypted communication between the SPR and the central server.
• Stores the data securely when there is any disruption in communication with the

central server.

2.4 UbiqVue™ Multi-Patient Relay (MPR) Software
A standard Linux-based computing platform meeting the necessary specifications can
be transformed into a Multi-Patient Relay (MPR) device by installing the MPR software.
Following authentication, the MPR's functions can be configured remotely via the Central
server. The MPR facilitates communication with multiple Biosensors through a Wi-Fi
network (standard Access point) and with various third-party devices through a BLE
gateway*.

The MPR device performs the following functions:

• The MPR Device establishes communication to a preconfigured LifeSignals Central
server or 3rd party server, after appropriately authenticating itself.

• The MPR transmits any data received from Biosensors to the connected Central
Server as early as possible, subject to the availability of network connectivity.

• The MPR sends the data to the Central Server only in encrypted form, preventing
eavesdropping of the data while in transit.

• The MPR securely buffers all received data in its memory temporarily (for at least 2
hours) with necessary encryption during communication breaks between the MPR
and Central Server.

2.5 UbiqVue™ Relay Bridge
The UbiqVue™ Relay Bridge shall provide communication between Biosensors and
Multi-Patient Relay instead of a standard access point, when Multi-Patient Relay
Software is hosted in the cloud.

A Relay Bridge application acts as a communication bridge between the Biosensor and
the Multi-Patient Relay (deployed on cloud). The Application will run on OpenWrt or
Linux based devices and it may help to reduce the infrastructure requirements,
facilitating easy deployment and increasing its portability. The Relay Bridge application
will support communication modes like Cellular, Wi-Fi and Ethernet.

• Relay Bridge replaces hardware like routers and access points in the biosensor
setup, providing a complete MPR solution without additional infrastructure.

2 UbiqVue™ Product description
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• The Relay Bridge hardware boasts router functionalities, including a WAN port,
cellular network support, battery backup, and access point capabilities. Additionally,
it is equipped with BLE technology to facilitate communication with third-party
devices.

• The Relay Bridge application, residing within the hardware, is responsible for
receiving data from the biosensor and transmitting it to the cloud MPR.

• Relay Bridge Software will allow the Biosensor to roam between multiple Relay
Bridge devices within the facility. (Relay bridges connected to a cloud Multi-Patient
Relay Software of a specific facility).

• The Relay Bridge Software can communicate with up to 8 biosensors
simultaneously.

2.6 UbiqVue™BLE Gateway
Bluetooth Gateway Software in UbiqVue™ 1AXWireless Patient Monitoring System
when installed in a standard OpenWrt based BLE gateway or BLE supported routers,
shall provide communication between the third-party BLE devices (e.g. BP device) and
Multi-Patient Relay. The Bluetooth Gateway communicates with multiple third-party
devices and transfers the data to the Multi-Patient Relaywithout buffering.

2.7 UbiqVue™ Central Server Software
The UbiqVue™ Central Server Software is installed on a compatible Linux based
hardware platform of LifeSignals, Inc. and performs the following functions:

• Authenticates the UbiqVue™ SPR and MPR devices, establishes secure connection
with relay devices over the internet.

• Manages the decryption, uploading and storage of Biosensor data received from
multiple authenticated relay devices.

• Contains the sensor processing library which processes and filters the received
physiological signals, then derives heart rate, respiration rate, skin temperature,
posture data for storage with the received Biosensor data.

• Allows access to derived parameter and Biosensor data using the UbiqVue™ Active
Monitoring Portal.

• Optional ability to send alert notifications to a configured destination e.g. email,
SMS, WhatsApp when the parameters (heart rate etc) of a specific Biosensor
(patient) exceeds the configured limits.

2.8 UbiqVue™ Active Monitoring Portal
The UbiqVue™ Active Monitoring Portal is a web-browser application and provides the
following:

• The Clinical Facility Administrator (CFA)* interface for management of roles
(Supervisory Clinician, Clinician, Physician, Additional Clinical Facility Admin,
patient groups and default alert configuration.

2 UbiqVue™ Product description



• Enables clinical personnel to login to central server remotely and access patient
physiological data and view alert status.

• Depending on the role of clinical personnel (normal or supervisory), they can access
data from multiple patients assigned to them and search for patients based on recent
alert status. This includes active patients (wearing Biosensor) and patients who have
completed the monitoring procedures.

• Monitoring Dashboard continuously displays physiological parameters, waveforms
and alert status of all assigned patients to authenticated clinical personnel for near
real-time active monitoring. Various options to view patient data can be selected,
including multiple patient tile view or single patient zoom view.

* The Clinical Facility Administrator is set up by the Service Provider Administrator.

2 UbiqVue™ Product description
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3 UbiqVue™ 1AX Wearable Biosensor

3.1 Patient advice
The following guidance should be given to the patient to ensure comfort while wearing
the Biosensor and optimal Biosensor performance. The information is also provided in
the Patient Information Leaflet found inside individual Biosensor packaging.

• Limit physical activity after the Biosensor has been applied to ensure good
adherence.

• Keep showers short with your back to the flow of water.
• If the Biosensor accidentally gets wet, gently pat dry with a towel and minimize

activity until fully dry.
• Avoid sleeping on the stomach, as this may interfere with the Biosensor

performance.
• Occasional skin itchiness and redness are normal around the Biosensor placement

area.
• Ensure the relay (mobile) device has sufficient battery charge during monitoring.
• Report symptoms such as dizziness, palpitations or breathlessness, press the

Biosensor Event button once. You may also be asked to record symptoms using the
UbiqVue™ Single Patient Relay App.

• Travel is permitted when wearing the Biosensor. If questioned during security
screening, show the Patient Information Leaflet.

3 UbiqVue™ 1AXWearable Biosensor
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3.2 LED status indicators
The Biosensor light (LED) provides information related to the functional status of the
Biosensor.

Table 1 - LED's - 1AX Wearable Biosensor

Light Behaviour Status

Slow flash Biosensor connected to the SPR/MPR devices or a monitoring
session is in progress.

Fast flash Biosensor attempting to connect with SPR / MPR devices.

Slow flash Low Battery

Alternate
flashing

Response to SPR - “Identify Biosensor” command.

Fast flash →
Off

Biosensor turned off.

3 UbiqVue™ 1AXWearable Biosensor



3.3 Skin preparation

Tip
Correct skin preparation will ensure the following:

l High patient comfort
l Reliable and robust ECG waveforms
l Artefact-free ECG reporting
l Good Biosensor adhesion for the wear duration

Tip
Avoid the use of wipes or isopropyl alcohol to clean the skin, as alcohol
dries the skin, increases the possibility of skin irritation and can reduce the
electrical signal to the Biosensor, thereby diminishing ECG waveforms.1

1. Sendelbach S et al, 2015/ Crit Care Nurse. 2015 Aug;35(4):15-22

1. If required, remove hair from the chest, preferably using clippers. Shaving should be
avoided as it is more likely to damage the skin and increase patient discomfort while
wearing the Biosensor.

Figure 2 - Biosensor placement area

2. Clean the area with non-moisturizing soap and water using a paper towel or gauze
swab. Using soap will remove grime or sweat on the skin and dissolves skin oils. This will
help reduce skin-to-Biosensor impedance which is required to achieve consistent, good
quality ECG waveforms.

3. Rinse the area thoroughly with a wet paper towel or gauze swab, making sure to
remove all soap residue.

4. Dry the area vigorously with a towel. The gentle abrasion will remove any dead skin
cells, further reducing impedance between the skin and the Biosensor. Drying with a
Towel will also increase skin blood flow, warming the skin for optimal Biosensor
adhesion.

3 UbiqVue™ 1AXWearable Biosensor
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3.4 Applying the Biosensor
1. Peel off the backing film.
2. Place the Biosensor on the chest, below the collar bone and the left of the breast

bone.

Figure 3 - Lifting left side of the Biosensor without moving the Biosensor out of place

3. Press the Biosensor for 2 minutes.

Figure 4 - Red lines indicating to press down on the Biosensor

3 UbiqVue™ 1AXWearable Biosensor



3.5 Removing the Biosensor

Tip
For patients with fragile or delicate skin, consider using an adhesive
remover when removing the Biosensor. Silicone-based adhesive
removers are preferred (instead of alcohol-based removers) as they fully
remove adhesive residue from the skin, do not cause skin dehydration or
an uncomfortable stinging sensation.

Follow these steps to prevent skin injury.1

1. Remove the Biosensor close to (parallel with) the skin surface while pulling it back
over itself.

Figure 5 - Biosensor removal

2. With the other hand, press the newly exposed skin to reduce skin stretch and
discomfort.

3. Gently, peel off the remaining Biosensor in the direction of hair growth.

1. Fumarola S et al, 2020/ J Wound Care 2020; 29(Suppl 3c):S1–S24.

3 UbiqVue™ 1AXWearable Biosensor
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4 UbiqVue™ Single Patient Relay
The SPR device will have the UbiqVue™ App pre-installed that manages the wireless
communication between the Wearable Biosensors and the UbiqVue™ Central Server.

4.1 Authenticating UbiqVue™ App - Relay (mobile) device

Notice
One Time Password (OTP) required for Clinician's first time use of the App
or whenever a new device is used. Contact LifeSignals customer support
for a list of compatible mobile phones to act as SPR devices. Use of
incompatible mobile phones may result in degraded performance.
OTP is mandatory to login to the App and also when the App restarts.
OTPs are received through email/phone.

1. Open the UbiqVue™ App on the relay (mobile) device.
2. Enter the Server ID i.e. server URL or scan the QR/barcode (sent via email/text

message), select NEXT.
3. Enter the Clinician login credentials, select NEXT to receive the OTP (if requested).
4. Enter the OTP, the App automatically authenticates the user.
5. Alternatively, for Patient/Other, enter the patient phone number and patient ID,

select NEXT to receive the OTP.
6. Enter the OTP, the App takes you automatically to the next screen.

4.2 Opening UbiqVue™ App -Relay (mobile) device
1. Open the UbiqVue™ App on the relay (mobile) device.

2. Enter the Clinician login credentials, select NEXT.

3. Alternatively, for Patient/Other, enter the patient phone number, select NEXT.

Note: Based on login (Patient login or Clinician login) the fields in the UI are displayed.

4 UbiqVue™ Single Patient Relay
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4.3 Starting a monitoring session - SPR

Notice
Check the expiry date and the outer package for any damage. If data is not
entered in the mandatory fields, an error message highlighting the fields
with missing information will appear. If the patient has been admitted using
the UbiqVue™ Active Monitoring Portal, patient's information will auto-
populate in the UbiqVue™ App.

1. Remove the Biosensor from the pouch.
2. Enter the Biosensor ID in the UbiqVue™ App manually or by scanning the QR code

on the Biosensor packaging. It takes you to the next screen automatically.

3. Press the Biosensor ON button once. A red light will flash followed by a flashing
green light and the Biosensor will automatically connect to the SPR.

4. Enter the Patient Info (include mandatory fields) in the UbiqVue™ App, select
ADMIT.

5. Prepare the patient's skin, select NEXT.
6. Follow the UbiqVue™ App instructions to apply the Biosensor, press the entire

Biosensor for two minutes, select NEXT.
7. Assess quality of ECG, if acceptable, select TRANSFER to use the hospital network

for Biosensor data transmission to the Central Server and CONFIRM to start the

monitoring session. If unacceptable, go to the menu , select Replace
Biosensor and enter the new Biosensor ID.

4.4 Transmitting Biosensor data - SPR
1. Select CONTINUE.
2. The UbiqVue™ App supports compatible Regulatory cleared SpO2 / BP devices.
3. Select the device type, enter the device ID manually or scan the QR code on the

device.
4. Alternatively, select SKIP to add the device later.

Now the Biosensor is connected, if the connectivity is lost, the SPR device will make
an audible alert.

4.5 Recording symptoms
1. Press the Event button on the Biosensor or select Events in the UbiqVue™ App.
2. Select the appropriate symptoms and activity.
3. Select Done.
4. Patient activated events can be viewed in the UbiqVue™Active Monitoring Portal.

The Clinician can input additional comments about the event if required.
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4.6 Recording measurements
1. Press the RECORD MEASUREMENTS button on the UbiqVue™ App.
2. Enter the time (24 hr format).
3. Enter the measurements for Blood Pressure and SpO2.
4. Select CONFIRM.
5. You can view the measurements in the UbiqVue™Active Monitoring Portal.

4.7 Additional menu features

In the SPR UbiqVue™ App, select to access the additional menu features.

Table 2 - Additional Menu Features

Feature Explanation Action

Monitoring Summary Provides current details of the
monitoring session.

Select Monitoring Summary
and BACK to exit.

Stop Monitoring The App will attempt to upload
data and turn off the Biosensor.
This may take a few minutes.
When fully stopped, follow
Remove Biosensor steps.

Select Stop Monitoring, then
CONFIRM. Follow Remove
Biosensor steps, select EXIT.

Add/Change Device(s) BP and SpO2 devices can be
added/changed to facilitate
measurement transmission to
the Central Server.

Select Add / Change Device
(s). Select device type, enter
the Device ID and select ADD
DEVICE.

Replace Biosensor The App will attempt to upload
data and turn off the
Biosensor.This may take a few
minutes. When fully stopped,
follow Remove Biosensor
steps.

Select Replace Biosensor.
Follow Remove Biosensor
steps, select DONE. A new
Biosensor can then be
applied.

Identify Biosensor The monitored Biosensor LED
will flash three times.

Select Identify Biosensor.

4 UbiqVue™ Single Patient Relay
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Transfer (Hospital Network) Biosensor data transmission
will be transferred from the
SPR to the hospital network
(MPR).

Select Transfer (Hospital Net-
work). The App will contact
the Central Server for details.
Select CONFIRM. Ensure
reconfiguration is successful,
select YES. If the Biosensor is
transferred, select YES. If not,
select NO.

Help Website link to user manuals. The link is directed to the web-
site with user manuals.

About Outlines additional App inform-
ation

Select About to view inform-
ation and BACK to exit.
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5 UbiqVue™ Multi-Patient Relay Software
Follow the steps outlined in the DHF09-LBL-004 UbiqVue™ MPR Installation &
Configuration Manual.

5 UbiqVue™ Multi-Patient Relay Software
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6 UbiqVue™ Relay Bridge
For more information, refer the DHF09-LBL-007 UbiqVue™ Relay Bridge Software
Installation & Configuration Manual.

6 UbiqVue™ Relay Bridge
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7 UbiqVue BLE Gateway
Refer the DHF09-LBL-004 UbiqVue™ MPR Installation & Configuration Manual and
the DHF09-LBL-007 UbiqVue™ Relay Bridge Software Installation & Configuration
Manual.

7 UbiqVue BLE Gateway
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8 UbiqVue™ Active Monitoring Portal
The UbiqVue™ Active Monitoring Portal is the central gateway for facility administrators
and clinical teams to access patient data and user settings according to the following
user permissions:

• Set up and manage user access and permissions to patient data and system
function settings for a single facility or group facility.

• Manage and initiate patient monitoring sessions, and their individual alert settings.
• Access displays of near real-time and stored continuous monitoring of patient vital

signs data from admission to discharge, whether the patient is in, or transitions
to/from a home or clinical environment.

• Manage default settings and alerts.
• View session, daily or end of monitoring patient reports generated from the

consolidated vital sign data collated from the Biosensors, third-party devices and
Clinician notes.

8.1 Users and roles
The user hierarchy for the Active Monitoring Portal helps to maintain the privacy and
security of patient information and permits system functions to be set on a facility-wide
basis. By assigning user roles and permissions, the system ensures that only authorized
users have access to patient data and the ability to configure the Active Monitoring Portal
settings. Each user will have specified roles (functions) and permissions to access the
Portal settings and patient data. Users can be assigned one or more roles (functions)
with pre-configured set of privileges. The User Hierarchy is shown below.

Figure 6 - User Hierarchy

8 UbiqVue™ Active Monitoring Portal
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8.1.1 Protected Health Information (PHI) Consent

It is mandatory for all users to accept the PHI Consent when logging in for the first time
before setting the Password.

Notice
The Protected Health Information (PHI) is any information in the medical
record or designated record set that can be used to identify an individual
and that was created, used, or disclosed in the course of providing a
health care service such as diagnosis or treatment.

Figure 7 - PHI Consent Screen

8.1.2 Service Provider Administrator (SPA)

The SPA manages the administration of clinical facilities and can perform the following
functions:
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SPA User Management

• Create another SPA.
• Enable/disable users (cannot delete) and edit their contact details.
• Reset password for users (a temporary password is sent to the registered email

address).
• Add Referral Physician (permission for access must be granted by CFA).
• Download Audit logs.

Clinical Facility Management

• Add new clinical facility (unique ID automatically assigned).
• Edit contact details of clinical facilities.
• Enable/disable multi-factor authentication.
• Configure the data storage period for each clinical facility.
• Manage admin for each clinical facility (add/enable/disable CFA).
• Download Audit logs.

Figure 8 - Download Audit Logs

Tip
Only SPA (default SPA) created by the Super Administrator can
assign/remove SPA role to/from one or more users.
If the default SPA is disabled by Super Administrator, all the SPA's
created by default SPA will automatically be disabled.

8.1.3 Clinical Facility User with Admin Privilege. Clinical Facility Admin-
istrator (CFA)

The Clinical Facility Administrator (CFA) has multiple functions associated with overall
set up and configuration of Active Monitoring Portal for the clinical facility. For example,
creates assign roles (SC/Clinician/Physician/Additional Clinical Facility Admin) for new

8 UbiqVue™ Active Monitoring Portal
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users, reset user's password, selects patient identification method for the facility (MRN
or Patient ID), creates location/medical groups and configures alert defaults for the entire
clinical facility.

The CFA login is created by the Service Provider Administrator (SPA). Contact the SPA
for access.

Tip
CFA cannot view or access individual patient data or Monitoring
Dashboard.

After logging in to the UbiqVue™ Active Monitoring Portal, the CFA can perform the
following functions:

User Management

• Add/edit roles for users (Supervisory Clinician, Clinician, Physician, Additional
Clinical Facility Admin)

• Edit contact details of users (Supervisory Clinician, Clinician, Physician,
Additional Clinical Facility Admin).

• Rename user roles in the Active Monitoring Portal.
• Add/ Delete patient groups based on location or medical group to Clinician or

Physician only.
• Enable/disable users (cannot delete)
• Reset password for users (temporary password sent to user email address and

mobile number)

Patient Group Management

• Create/Add/Edit/Delete levels in locations and medical group.

Relay Management

• Send SERVER ID/QR code to the registered SPR device.
• Delete SPR relay IDs.
• Add/Delete MPR Server key.
• Enable/Disable SPR auto deletion date.

Default Alert Configuration (for the facility)

• Enable/Disable/Edit the clinical and technical alerts and alert priority for the
clinical facility.

• Set the alert destination for clinical, manual, and technical alerts (SMS, Email,
WhatsApp)

• Set the alert Notifications (notification message for Clinician / Supervisory
Clinician / Physician).

Miscellaneous

• ECG Settings (Select/Edit ECG filter settings and Select/Edit ECG sampling
rate).
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• Network Reconfigurations (Enable/Disable/Edit Biosensor wireless network
configuration).

• Other Settings: Enable/Disable auto generation of Patient ID/MRN, access to
select Service Provider Referral Physician, Mandatory note for parameter
acknowledgment, Mandatory note on discharge, Display Pulse Rate in Patient
Zoom View, select Patient Identification (local terminology i.e. MRN or PID),
Enter facility name, Upload a file for co-branding logo and Patient barcode
parsing.

Audit Log

• Download the Audit logs for the required year and month

8.1.4 Clinical Facility User with Supervisory Clinician Privilege

The Supervisory Clinician (SC) can view all patients or patient groups in the clinical
facility, acknowledge alerts for all patients in clinical facility using the Active Monitoring
Portal. SC can set/edit default alarms for specific groups of patients, assign patients or
patient groups to the user with Clinician or Physician role and view discharged patients.

The SC login is created by the CFA. Contact CFA for access.

Tip
Only the SC can access the list of discharged patients, view trends and
generate reports for discharged patients in the Home screen. SC cannot
admit patients or add events/notes.

8.1.5 Clinical Facility User with Clinician Privilege

The Clinician can admit patients, assign new patients to any location or medical group,
set/edit default alert limits for any assigned patients, view data and acknowledge alerts
of multiple assigned patients, enter manual Events/Notes, SpO2, Pulse Rate, BP value
using the Monitoring Portal. The Clinician login is created by the CFA. Contact the CFA
for access.

Tip
Only the Clinician can admit patients. The Clinician cannot access the list
of discharged patients or view trends and generate reports for discharged
patients in the Home screen.

8 UbiqVue™ Active Monitoring Portal
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8.1.6 Clinical Facility User with Physician Privilege

The Physician can set/edit default alert limits for any assigned patients, view data and
acknowledge alerts of multiple assigned patients or patient groups, enter manual
Events/Notes, SpO2, Pulse Rate, BP values using the Active Monitoring Portal.

The Physician login is created by the SPA or CFA. Contact the SPA or CFA for access.

Tip
If the SPA creates Physician login, then the Physician may have access to
patients in multiple clinical facilities when the Physician is selected during
patient admission.
Whereas, if the CFA creates the login, then the Physician will have access
to patients in the single clinical facility only.
The Physician cannot admit patients or access discharged patients in the
Home screen.

8.1.7 Main display screens

The UbiqVue™ Active Monitoring Portal displays three screens; Home, Monitoring
Dashboard and Settings, supporting clinical workflows and functions.

1. Home screen

The Home screen is the primary navigation screen for all core functions of UbiqVue™
including Patient Management, Clinical and Technical Alerts. The Home screen also
provides quick access to the Monitoring Dashboard, Settings and User information. User
permissions provide access to various functions.

Admit Patients | Current Patients | Discharged Patients | Clinical Alerts | Technical Alerts.
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Figure 9 - Home Screen
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2. Monitoring Dashboard

The Monitoring Dashboard displays near real-time waves, numerics, and alarms from
multiple patients. Patient tiles can be selected to view individual patient data, trends and
alert settings (Zoom View). Supervisory Clinicians, Physicians, and Clinicians can
remotely access the Monitoring Dashboard.

Figure 10 - Monitoring Dashboard
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3. Settings screen

The Settings screen provides access to functions enabling management of authorized
users permitted to access the Active Monitoring Portal, creating and managing patient
groups and associated app settings. Additional rules and Active Monitoring Portal
functions can also be set through the settings screen. Only the CFA is authorized to
configure default settings.

User Management | Patient Group Management | Relay Management | Default Alert
Configuration | Miscellaneous | Audit Log

Figure 11 - Settings Screen

8.2 Patient management
Patient management provides functions to enable users to:

• Manage patient transitions from admission to discharge, whether the patient is
located at home or in a clinical environment.

• Enter and update patient information.
• Enter and update Physicians or Caregivers to receive notifications for the patient.
• Manage the Biosensors and third-party device assigned to a patient .
• Enter Events and notes into the patient record.

Users with the roles of Supervisory Clinician, Clinician and Physician manage the
patients in the clinical facility and perform the clinical workflows outlined below using the
Active Monitoring Portal. A user can have multiple roles.
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Tip
Permission to admit/discharge patients, view patient vital signs and
configure clinical/technical alerts is dependent on the users privileges.

The beside the user icon denotes access to the respective clinical
workflow.

8.2.1 Admitting patient

To start monitoring a patient, follow the steps below to admit the patient to the Facility.

1. From the Admit Patients viewer → Select ADMIT PATIENT → Enter the patient
details* and the Biosensor ID→ SAVE.

2. Follow the step-by-step instructions shown in For more information, see "Skin
preparation" on page 12 and For more information, see "Applying the Biosensor" on
page 13.

3. Complete the patient admission to UbiqVue™. Note that the patient's vital sign data
will immediately begin streaming to the Active Monitoring Portal.

4. Return to the Active Monitoring Portal and view the patient vital sign data displayed
on the Monitoring Dashboard.

* Mandatory

** Data will be auto-populated if the patient demographics have been previously entered in the Active Monitoring Portal.

Notice
In cases where the Biosensor has been applied to a patient BEFORE
admitting a patient, using the relay device or the Active Monitoring Portal,
the patient is NOT being actively monitored, no alarms will be generated
and the Biosensor data will not be displayed on the Monitoring Dashboard.
It is advised to always follow the Admitting patient procedure detailed
above to ensure a patient can be monitored as soon as the Biosensor is
applied, .

Mandatory Fields

PATIENT ID / MRN Enter the Patient ID /MRN. The Patient ID can also be auto-
generated by tapping the Autogenerate icon.

FIRST NAME Enter the First Name of the Patient.

LAST NAME Enter the Last Name of the Patient.

DATE OF BIRTH Select the Year, Month and the Day from the Calendar. (Birthdate of
the patient).

SEX Select the sex from the drop-down list.
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PHONE NUMBER Enter the Phone number for the Patient.

ADMITTED ON Select the Year, Month and the Day from the Calendar. (Admission
date of the patient).

BIOSENSOR ID Enter the Biosensor ID and select . 

Figure 12 - Admit Patient Screen

8 UbiqVue™ Active Monitoring Portal

UbiqVueTM 1AXWireless Patient Monitoring System| User Manual 32 of 77



33 of 77 UbiqVueTM 1AXWireless Patient Monitoring System| User Manual

Notice
ADDITIONAL INFORMATION field - Information related to the medical
history and admission condition of the patient must be entered.

8.2.2 Transferring to Hospital Network (MPR)

When an admitted patient is relocated from an SPR setting to an MPR setting e.g. from
the patient's home or a step-down facility to a hospital ward, the Transfer to Hospital
Network function enables the seamless transfer of continuous vital sign monitoring
without the requirement to remove the assigned Biosensor.

1. From the Current Patients window→ → Transfer to Hospital Network →
CONFIRM→ Transfer Initiated.

8.2.3 Editing patient

Choosing the Edit option enables the user to modify all information for an individual
patient, except for the Patient ID, Admission ID, First Name, Last Name, Age, Date of
Birth, and Sex.

1. From the Current Patients window→ individual patient → Edit → edit
information → SAVE.

8.2.4 Discharging patient

When a patient monitoring session has been completed, the patient can be discharged
from the Active Monitoring Portal.

1. From the Current Patients window→ individual patient →Discharge →
CONFIRM→OK

8.2.5 Transfer from Hospital Network (SPR)

When an admitted patient is relocated from an MPR setting to an SPR setting e.g. from a
hospital ward to the patient's home or a step-down facility, the Transfer from Hospital
Network function enables the seamless transfer of continuous vital sign monitoring
without the requirement to remove the assigned Biosensor.

1. From the Current Patients window→ → Transfer from Hospital Network →
CONFIRM→ Transfer Initiated.
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8.2.6 Adding Biosensor

If a patient requires a new Biosensor to be applied i.e. previous Biosensor wear-life
completed, removed for MRI, this function permits continuation of patient monitoring
session. There are two ways to add Biosensor. They are:

1. From the Current Patients window→ (beside the Biosensor ID)→ ADD NEW

→ enter the Biosensor ID→ →SAVE.

Or

2. From the Current Patients window→Click the icon→ Edit → (beside the

Biosensor ID)→ ADD NEW→Enter the Biosensor ID→ →SAVE.

8.2.7 Extending discharge

Every patient has an estimated discharge date* scheduled on their patient file i.e. when
monitoring is no longer required or when the patient leaves the hospital. If a new
Biosensor is applied, the discharge date will be automatically updated. If a patient's
Biosensor is not streaming data on the discharge date, the patient's details automatically
transfer from the current patients to the discharged patients.

1. From the Current Patients window→ individual patient → Edit → choose new
ESTIMATED DISCHARGE date → SAVE.

* Discharge date refers to entry in the UbiqVue™ Active Monitoring Portal.

8.2.8 Assigning/Reassigning patient to location/medical group

During patient admission, a physical location or medical group e.g. Cardiology,
Oncology can be assigned. This enables multiple patients to be managed according to
their location or medical group in near real time. If a patient has changed location or
medical group, details can be updated accordingly.

1. From the Current Patients window→ASSIGN GROUP→ Location/Medical Group
→ ASSIGN.

2. To reassign, select Location/Medical Group → choose new Location/Medical
Group →ASSIGN.
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8.2.9 Assigning/Reassigning Physician

During patient admission, a Physician can be assigned. If the patient has been
transferred from the care of one Physician to another, details can be updated
accordingly.

1. From the Current Patients window→ individual patient → Edit →
PHYSICIAN NAME (dropdown) → SAVE.

8.2.10 Assigning/Reassigning devices

During patient admission, a third party device e.g. BP / SpO2 device can be assigned to
the patient and data can be streamed to the Active Monitoring Portal together with the
other Biosensor data. When a patient's monitoring session has been completed, the
device can be reassigned.

1. Open the Current Patients window→ individual patient → Edit →THIRD
PARTY DEVICE TYPE→ enter the DEVICE ID→ SAVE.

2. To assign more devices, select → enter the details → SAVE.

3. To reassign devices, select → enter the details → SAVE.
4. To pair Third-party devices:

Keep the third-party device close to the Bluetooth gateway (Access Point).
5. Long press the pairing button on the third-party device.
6. When the devices are paired, you can start taking the readings.

8.2.11 Stop monitoring

When a patient's monitoring session has been completed, the status should be first
updated in the Active Monitoring Portal, before removing the Biosensor to ensure all the
data is captured.

1. From the Monitoring Dashboard → patient zoom view→ STOP MONITORING→
CONFIRM→OK.

Or

2. From the Current Patients window→ Select the icon → CONFIRM→OK.

Notice
Ensure the Biosensor is switched off (LED no longer flashing).

3. Follow the steps for removing the Biosensor. For more information, see "Removing
the Biosensor " on page 14.
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8.2.12 Adding events/notes

If a Patient pushes the Biosensor event button, a record will show in the patient tile.
Supplementary notes can be added by the Clinician with further information to assist with
patient monitoring records.

1. From the Monitoring Dashboard → patient zoom view→ ADD EVENT→ select
Symptoms/Activities or Record Note → SAVE.

2. From the Current Patients window→ ADD EVENT/NOTE→ select
Symptoms/Activities or Record Note → SAVE.

8.3 Patient monitoring
The Active Monitoring Portal provides access to multiple patient physiological
measurements, posture status and alarm events, continuously streamed from the
Biosensor and third party device. This information is displayed in various formats to
assist in reviewing a patient’s status. Continuous physiological data can be streamed in
near-real time from the patients located in a clinical or home environment. When
intermittent data is captured using third party devices e.g. Pulse Rate, BP / SpO2, it may
be required to update the parameters manually.

8.3.1 Current patients

The Current Patient screen displays a list of actively streaming patients and non-
streaming patients (Stop monitored patients), , and their vital sign measurements.

1. From the Current Patients window, view the patient details e.g. MRN, PATIENT
NAME, MONITORING STATUS.

Figure 13 - Current Patient Screen
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2. Filter the patients based on Location or Medical Group.
3. Sort the patient list shown in the window based on MRN/ PATIENT NAME/

MONITORING/ ID.

Notice
MRN - Clicking on the MRN of a particular patient will direct you to the
Hybrid view of the Patient.

4. To view the patient information → select the icon (Medication, Clinical indication
and Additional Information details of the Patient can also be viewed).

Figure 14 - More Info Screen

5. To view the Biosensor information or Add Biosensor to the Patient → select the .
icon.
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Figure 15 - View Biosensor Info and Add Biosensor Screen

6. User can start / stop (ON /OFF) Alerts for specific time intervals (15 Mins, 30 Mins,
45 Mins, 60 Mins, and 120 Mins).
Paused alerts DO NOT reach the Destinations (SMS, WhatsApp, Email).

Figure 16 - Pause Alerts
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8.3.2 Patient trends

The Trends window displays a patient’s physiological measurements over a selected
timeline.

1. From the Monitoring Dashboard → patient zoom view→TRENDS→ select
Admission No → Select recent Time interval → Select Date/Time (From and To)
Parameter 1 and Parameter 2 (select HR or PR or SpO2 or RR or Skin Temp or
BP).

Figure 17 - Patient Trends Screen

Notice
Based on the first channel selection, user shall be able to select the
corresponding waveforms in the second channel
Parameter 1 and Parameter 2 represent vital data related to HR, PR,
SpO2, RR, Skin Temp, and BP.
When the HR is selected in Parameter 1, Parameter 2 can also display the
ECG A or ECG B of the patient.

Alternatively,
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2. From the Current Patients window→ →VIEW TRENDS→ select Admission
No→ Select recent Time interval → Select Date / Time (From and To) → Select
Parameter 1 and 2.

Figure 18 - Patient Trends - Parameter Alerts

Notice
Parameter alerts are displayed in Red.
Technical alerts are displayed in Blue.

Figure 19 - Patient Trends - Technical Alerts

8.3.3 Monitoring Dashboard

The Multi-Patient monitoring window displays continuous physiological parameters,
waveforms and alert status of assigned patients to authenticated clinical personnel for
near-real time active monitoring. It has the option for user to select multiple patient tile
view or single patient zoom view for any patient using the available filter settings.

1. Filter the patients based on Location, Medical condition and Parameter alerts.
2. Sort the dashboard based on MRN, Patient First name, Biosensor ID.

8 UbiqVue™ Active Monitoring Portal

UbiqVueTM 1AXWireless Patient Monitoring System| User Manual 40 of 77



41 of 77 UbiqVueTM 1AXWireless Patient Monitoring System| User Manual

3. To view BP in patient tile, select → .

4. To view ECG in patient tile, select → .

5. To view BP and ECG in patient tile, select → .

6. To view Group Grid View, select → .
a. Overview about the patient active alerts- Active Parameter/Technical/Manual

alerts.

b. To view detailed alert window, select → .
7. Add Patient to the Monitoring Dashboard.
8. Select individual patient tile to go to zoom view.

Figure 20 - Zoom View Screen

Notice
The Clinical alerts are displayed for the selected patient in the Zoom view
next to the patient name.
The Technical alerts are displayed in the Zoom view next to the Biosensor.

8 UbiqVue™ Active Monitoring Portal



Figure 21 - Zoom View - Clinical Alert Display

8.3.4 Updating blood pressure

If the blood pressure device utilized is not transmitting data to the Active Monitoring
Portal, measurements can be entered manually in the patient record.

1. From the Monitoring Dashboard → patient zoom view→ select the icon in the
Blood Pressure tile → Enter the BP values → SAVE

Notice
View Logs provides the log details of the previous three modifications with
time stamp.

8.3.5 Updating SpO2 / Pulse Rate

If an SpO2 device utilised is not transmitting data to the Active Monitoring Portal,
measurements can be entered manually in the patient record.

1. From the Monitoring Dashboard → patient zoom view→ select the icon in the
Spo2 / Pulse Rate tile →Enter the values → SAVE..

Notice
View Logs provides the log details of the previous three modifications with
time stamp.
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8.3.6 Requesting patient report

A patient report can be generated during a monitoring session and/or at the end of a
monitoring session. Parameters and timelines can be selected for the entire monitoring
session. Once the report has been requested, the report will be shown in the View
Report section. The time to generate the report will depend on the duration of the
monitoring session.

1. From the Monitoring Dashboard → patient zoom view→ Trends → select the
Date/Time (From and To) → Select Request Report -> Request Monitoring
Report/Request Daily Report.

8.3.7 Downloading patient report

Patient reports can be downloaded in a PDF format.

1. From the Monitoring Dashboard → patient zoom view→ TRENDS→ View Report

→ select .

Or

2. From the Current Patients window→Individual patient, Select the icon→ View
Trends→ Select GENERATE Report.

8.3.8 Viewing and Downloading alert log*

Each patient alert is captured and stored within the Active Monitoring Portal. Users can
view and download the list of alerts for further review.

1. From the Monitoring Dashboard → patient zoom view→ ALERTS → select

* Alert logs are stored in the AWS cloud. If memory storage is full, the alert logs will be stored in the backup.

8.3.9 Viewing and Downloading Event Log*

When a patient experiences any kind of discomfort symptoms, the event button on the
Biosensor can be activated. This facilitates the event to be recorded on the Dashboard.
Users can view and download the list of alerts for further review.

From the Monitoring Dashboard → patient zoom view→ ALERTS → EVENT LIST →

Select .
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8.4 Alert management
The Active Monitoring Portal generates alerts notifications that can be viewed on the
Monitoring Dashboard. When an alert notification is raised, clinical staff can view details
of the alert, acknowledge receipt, take necessary action and forward the alert details to
another clinical team member, if necessary.

Clinical Alerts - indicates the patient's physiological measurements collated from the
Biosensor and third party devices that have fallen outside the pre-set alert parameters.

Technical Alerts - indicates the Biosensor cannot measure or detect alerts reliably e.g.
The Biosensor has slipped off or is out of battery.

Clinical and Technical Alerts can be pre-configured in the Settings screen. Details of
Alert messages can be found here Alerts.htm.

Caution
Always check the default alarm settings are appropriate prior to monitoring
individual patients as extreme parameters may make the alert system
ineffective.

8.4.1 Viewing and acknowledging clinical alerts

A list of all generated clinical alerts by location, medical group or vital sign parameters
can be reviewed and acknowledged in the Clinical Alerts tab. Along with the current
Clinical Alerts, the alerts that were generated in the last 30 minutes, 1 hour, 3 hours, and
6 hours can also be viewed.
To view and acknowledge the required clinical alerts:

1. From the Home screen, navigate to Clinical Alerts window→ Select View →Select
the search criteria for alerts based on Location/Medical Group /Parameter /Priority
→Select Search.

2. The various details pertaining to the MRN, Patient Name, Groups, Alert Time,
Alerts, and Status are displayed.

3. Select Acknowledge to acknowledge the alerts.

4. Click the icon, and select the desired options.
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Figure 22 - Clinical Alerts Screen

8.4.2 Viewing and acknowledging technical alerts

A list of all generated technical alerts by location, medical group or vital sign parameter
can be reviewed and acknowledged. To view and acknowledge the required technical
alerts.

1. From the Home screen, navigate to Technical Alerts window→ Select View
→Select the search criteria for alerts based on Location/Medical Group/Alert Type
→ Select Search.

2. The various details pertaining to the MRN, Patient Name, Groups, Biosensor ID,
Monitoring, Alert Time, Alerts and Status are displayed.

3. Click Acknowledge to aclnowledge the alerts. (The Acknowledged alerts denote the
alerts that have been acknowledged).

Figure 23 - Technical Alerts Screen

8.4.3 Viewing and acknowledging manual alerts

1. From the individual patient zoom view→ ALERTS→ EVENT LIST → enter the
SYMPTOMS/ACTIVITY/NOTE.
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8.4.4 Forwarding alerts

Details of a patient alert can be forwarded to members of the clinical team for review.

1. From the Clinical Alerts window→ Select → Forward Alert → Select Role
(Supervisory Clinician / Clinician / Physician ) → Select User → Select Alert
Type → SEND.

8.4.5 Configuring clinical alerts

Default settings for clinical alerts are pre-set for each vital sign measurement. If required,
clinical alert settings can be configured for an individual patient, patient group or for all
patients in a clinical facility. Alert configurations include setting vital sign thresholds,
selecting the duration of the vital signs falling outside the given parameter before raising
an alert and prioritizing the alerts listed.

Individual patient 

1. From the Monitoring Dashboard → patient zoom view→ ALERTS →CLINICAL.

2. To configure threshold and delay time, select → enter the values → →
SAVE.

3. To configure priority, select → choose the priority → → SAVE.

4. To enable/disable alerts -> . For more information, see "Configuring technical
alerts " on page 47.

Group

1. Select Settings, open Default Alert Configuration window.

2. To configure threshold and delay time, select → enter the values → →
SAVE.

3. To configure priority, select → choose the priority → → SAVE.

Tip
Only the SC can configure clinical alerts for patient groups.

Clinical facility

1. Select Settings, open Default Alert Configuration window.

2. To configure threshold and delay time, select → enter the values → →
SAVE.
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3. To configure priority, select → choose the priority → → SAVE.

Tip
Only the CFA can configure clinical alerts for clinical facility.

8.4.6 Configuring technical alerts

Technical alerts relate to the Biosensor being unable to capture signals from the patient
or transmit vital sign data to the Active Monitoring Portal. Technical alert settings can be
configured for an individual patient, patient group or for all patients in a clinical facility.
For group and clinical facility settings, technical alert configurations include setting the
alert frequency and selecting the delay time or duration before an alert is raised.

Refer to Alerts.htm for further information.

Individual patient 

1. From the Monitoring Dashboard → patient zoom view→ ALERTS → TECHNICAL.
2. View technical alerts.

3. To enable/disable alerts → .

Group

1. From Settings → Default Alert Configuration window→ TECHNICAL ALERTS.

2. To configure ALERT FREQUENCY/DELAY TIME→ → enter values → →
SAVE.

Tip
Only the SC can configure technical alerts for patient groups.

Clinical facility

1. From Settings → Default Alert Configuration window→ TECHNICAL ALERTS.

2. To configure ALERT FREQUENCY/DELAY TIME→ → enter the values →

→SAVE.

Tip
Only the CFA can configure technical alerts for clinical facility.
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8.4.7 Configuring alert destination

Clinical and technical alerts can be sent via various communciation tools (SMS/
WhatsApp/Email) to individual users.

Individual patient 

1. From the Monitoring Dashboard → patient zoom view→ ALERTS →
DESTINATIONS.

2. Enable communication tool→ select user → select → SAVE.

Group

1. From Settings → Default Alert Configuration window→ ALERT DESTINATION.

2. Enable communication tool → select user → →SAVE.

Tip
Only the SC can configure alert destination for patient groups.

Clinical facility

1. From Settings → Default Alert Configuration window→ ALERT DESTINATION.

2. Enable communication tool→ select user → →SAVE.

Tip
Only the CFA can configure alert destination for clinical facility.

8.5 Network and facility settings (CFA only )

Tip
CFA can select RESET TO FACTORY DEFAULT in the Default Alert
Configuration and Miscellaneous windows.

8.5.1 Network Reconfiguration

The CFA can reconfigure network settings for clinical facility.
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1. Select Settings, open Miscellaneous window, select NETWORK
RECONFIGURATION.

2. Enable/Disable Biosensor wireless network configuration → SAVE.
3. To change RELAY PASSWORD/HOSPITAL SSID/HOSPITAL PASSWORD→

→ enter the text → → SAVE.

8.5.2 Facility settings

The CFA can configure various other settings in the Active Monitoring Portal which
include Enabling/Disabling auto generation of Patient ID/MRN, allowing SC/Clinician
access to select Service Provider Referral Physician during patient admission,
mandatory note for parameter acknowledgment, mandatory note on discharge, Display
Pulse Rate in Patient Zoom View, select Patient Identification (local terminology i.e.
MRN or PID), enter facility name, upload a file for co-branding logo and patient barcode
parsing.

1. Select Settings, open the Miscellaneous window, select OTHER SETTINGS.
2. To enable/disable Auto generation of Patient ID / MRN, select from the dropdown

→ SAVE.
3. To enable/disable Access to Service Provider Physician, select from the dropdown

→ SAVE.

4. To enter Facility Name, select → enter the text → → SAVE.

5. To choose Co-branding Logo, select → choose the image file → SAVE.

6. To choose Patient Barcode Parsing, select → choose the image file → SAVE.
7. To select Patient Identification, select from the dropdown menu→ SAVE.
8. To select Mandatory Note for parameter acknowledgement, select from the

dropdown menu→ SAVE.
9. To select Mandatory Note on Discharge, select from the

drop-down menu→ SAVE.
10. To select Display Pulse Rate in Patient Zoom View, select from the

drop-down menu→ SAVE.

8.5.3 Configuring ECG Settings

1. From the Settings →Miscellaneous window→ ECG SETTINGS→ Select/ Edit
diagnostic/ monitoring → select/ edit sampling rate → SAVE.
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9 Specifications

9.1 UbiqVue™ 1AX Wireless Patient Monitoring System

Table 3 - Technical Specification

Physical (Biosensor)

Dimensions 105 mm x 94 mm x 12 mm

Weight 28 g

Status LED Indicators Amber, Red and Green

Patient Event Logging Button Yes

Water ingress protection IP24

Color White

Specifications (Biosensor)

Battery type Primary Lithium Manganese dioxide (Li-MnO2)

Battery Life
120 hours (under continuous transmission under normal
wireless environment)

Wear Life 120 hours (5 days)

Defib Protection Yes

Applied Part Classification Defibrillation-proof type CF applied part

Operations Continuous

HF Surgical Equipment Com-
patability

Yes

Intended environment Home, Clinical and Non-Clinical facilities

Intended Population 18 years or older

MRI safe No

Single Use / Disposable Yes

ECG Performance and Specifications

ECG number of channels Two

ECG sampling rate 244.14 and 976.56 samples per second (sps)

Frequency response 0.2 Hz to 40 Hz and 0.05 Hz to 150 Hz

Lead off detection Yes
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Common Mode rejection ratio > 90 dB

Input Impedance > 10 Mega ohms at 10 Hz

ADC Resolution 16 bits

ECG Electrode Hydrogel

Heart Rate

Heart Rate range 30 – 250 bpm

Heart Rate accuracy (Stationary
& Ambulatory)

±3 bpm or ±10% whichever is greater

Heart Rate resolution 1 bpm

Heart Rate Averaging Method Heart rate is computed by averaging the 8 most recent R-R
intervals

Time to Alarm for 206 BPM /
1mVpv (Ref : IEC 60601-2-27 :
B1 waveform 201.7.9.2.9.101 -
b6)

Gain 0.5 (0.5 mV): 34 seconds
Gain 1.0 (1.0 mV): 21 seconds
Gain 2.0 (2.0 mV): 17 seconds

Time to Alarm for 195 BPM /
1mVpv (Ref : IEC 60601-2-27 :
B2 waveform 201.7.9.2.9.101 -
b6)

Gain 0.5 (0.5 mV): 17 seconds
Gain 1.0 (1.0 mV): 17 seconds
Gain 2.0 (2.0 mV): 15 seconds

Response Time of Heart Rate
Meter to Change in Heart Rate

HR change from 80 to 120 bpm: Average 15 seconds
HR change from 80 to 40 bpm: Average 19 seconds

Heart Rate Meter Accuracy and
Response to Irregular Rhythm

Ref : IEC 60601-2-27 : A1 waveform : 80 bpm
Ref : IEC 60601-2-27 : A2 waveform : 60 bpm
Ref : IEC 60601-2-27 : A3 waveform : 120 bpm
Ref : IEC 60601-2-27 : A4 waveform : 90 bpm

Update period Every beat

Heart Rate Method Modified Pan-Tompkins

Tall T-wave Rejection Capability 1.2 mV

Respiration Rate **

Measurement Range 5 – 60 breaths per minute

Measurement Accuracy 9-30 Breaths per Minute with a mean absolute error of less
than 3 Breaths per Minute, validated by clinical studies

6-60 Breaths per Minute with a mean absolute error of less
than 1 Breaths per Minute, validated by simulation studies

Resolution 1 breath per minute

Respiration rate algorithm Trans-thoracic Impedance (TTI), Accelerometer and ECG
Derived Respiration (EDR).
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TTI injection signal frequency 10 kHz

TTI Impedance variation range 1 to 5 Ω

TTI Base Impedance 200 to 2500 Ω

Update period 4 sec

Maximum Latency 20 sec

EDR - ECG derived respiration R-S amplitude

Skin Temperature

Measurement Range 29°C to 43 °C

Measurement Accuracy
(laboratory)

± 0.2°C

Resolution 0.1°C

Sensor Type Thermistor

Measurement Site Skin (chest)

Update Frequency 1 Hz

Accelerometer

Accelerometer Sensor 3-Axis (digital)

Sampling Frequency 25 Hz

Dynamic Range ± 2 g

Resolution 16 bits

Posture Lying, Upright, Inclined

Wireless and Security

Frequency Band (802.11b) 2.400-2.4835 GHz

Bandwidth 20 MHz (WLAN)

Transmit Power 0 dBm

Modulation Complementary Code Keying (CCK) and Direct Sequence
Spread Spectrum (DSSS)

Wireless Security WPA2-PSK / CCMP

Data Rate 1, 2, 5.5 and 11 Mbps

Wireless Range **** >5meters (line of sight)**

Environmental

Operational temperature    +0°C to +45°C (32°F to 113°F)
Maximum applied part measured temperature may vary by
0.5°C
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Operational relative humidity 10 % to 90 % (non-condensing)

Operational altitude up to 3000 m (10000 ft)

Storage temperature (< 30 days) +0°C to +45°C (32 °F to 113°F)

Storage temperature (≥ 30 days) +10°C to +27°C (50°F to 80°F)

Transportation temperature (≤
10 days)

-5°C to +50°C (23°F to 122 °F)

Storage relative humidity 10% to 90% (non-condensing)

Storage pressure 700 hPa to 1060 hPa

Shelf life 13 months

Notice
**** QoS verified for 5 meters range in bench setup.

Active Monitoring Portal software user interface (zoom view) designed for
the ECG display of fixed gain of 10 mm/mV and sweep speed of 25 mm/s.
However, Active Monitoring Portal is a browser-based application, the
height in mm could vary based on the resolution and size of the display
used. Hence, the horizontal gridlines (thinner line with 0.1 mV and thicker
line with 0.5 mV resolutions) are provided for measuring the amplitude.
Similarly, the width in mm could vary based on the resolution and size of
the display used. Hence, the vertical gridlines (thinner line with 0.04 ms
and thicker line with 0.2 ms resolutions) are provided for reference.
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Notice
• Biosensor has an automatic scan feature when the wireless link fails

for a channel. This feature finds best channel from the available 11
channels in 2.4GHz band and reconnects to it.

• 11b technology with higher adjacent channel rejection and spread
spectrum technique is being used for connectivity in hospital use
cases with higher deployment density. The throughput required per
patch is just 30kbps which is much lower than 5 Mbps throughput of
11b (0,6%). Therefore, the waveform breakage is the least
encountered.

• Tx power, DTIM and Beacon interval are set optimally for concurrent
monitoring of 100s of patients in a hospital. Smart rate control
algorithms in biosensor can find optimum link rate to minimize packet
loss and maximize capacity.

• Distance between the biosensor and the relay (WiFi AP for MPR or
SPR) to be maintained within 5m for eliminating waveform breaks.

• Keep the BLE relay within 5m from the Biosensor/patient in home use
case. In case of breaks reported by monitoring health care
professional, keep the relay close to the body but not right above the
biosensor.

• Technical alerts are sent over sms, whatsapp and email when the
biosensor is disconnected to alert the monitoring healthcare
professional. It is also displayed on the dashboard against each
biosensor.

Notice
When 5 minutes has elapsed from the latest respiration rate, SpO2, pulse
rate or BP measurements, the respective numeric value digits turn gray
(tile and zoom views).
When 15 minutes has elapsed from the latest Respiration Rate(RR)
measurement, the gray numeric value digits are replaced by a dashed
line.
When 60 minutes has elapsed from the latest Blood Pressure (BP), the
gray numeric value digits are replaced by a dashed line.
When 30 minutes has elapsed from the latest SpO2, the gray numeric
value digits are replaced by a dashed line.

9.2 Alerts

Notice
The Alert messages outlined in the table below will be displayed in the tile
and zoom (hybrid) views. When a parameter alert is triggered, the numeric
measurement in alert will always change to red (irrespective of priority).
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Table 4 - Parameter Alerts – Alarm Messages displayed on Active Monitoring Portal

Alert Message From Condition

Diastolic BP High (Based on 3rd
party device data)

BP Diastolic BP value has exceeded the high
alarm limit.

Diastolic BP Low (Based on 3rd
party device data)

BP Diastolic BP value has fallen below the low
alarm limit.

HR High ECG Heart Rate value has exceeded the high
alarm limit.

HR Low ECG Heart Rate value has fallen below the low
alarm limit.

Mean BP High (Based on 3rd
party device data)

BP Mean BP value has exceeded the high alarm
limit.

Mean BP Low (Based on 3rd party
device data)

BP Mean BP value has fallen below the low alarm
limit.

Pulse Rate High (Based on 3rd
party device data)

SpO2 SpO2 Pulse Rate value has exceeded the
high alarm limit.

Pulse Rate Low (Based on 3rd
party device data)

SpO2 SpO2 Pulse Rate value has fallen below the
low alarm limit.

RR High Resp. Respiration Rate value has exceeded the high
alarm limit.

RR Low Resp. Respiration Rate value has fallen below the
low alarm limit.

Same lying Posture (Bed Sore) Posture Lying Left/Right/Supine Posture value has
exceeded the alarm limit.

Skin Temp High Skin
Temp.

Skin Temperature value has exceeded the
high alarm limit.

Skin Temp Low Skin
Temp.

Skin Temperature value has fallen below the
low alarm limit.

SpO2 % High (Based on 3rd party
device data)

SpO2 Arterial oxygen saturation has exceeded the
high alarm limit.

SpO2 % Low (Based on 3rd party
device data)

SpO2 Arterial oxygen saturation has fallen below the
low alarm limit.

Systolic BP High (Based on 3rd
party device data)

BP Systolic BP value has exceeded the high
alarm limit.

Systolic BP Low (Based on 3rd
party device data)

BP The Systolic BP value has fallen below the low
alarm limit.
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Notice
The Alert messages outlined in the table below will be sent via
SMS/WhatsApp/Email to the configured users. Clinical personnel or
caregiver shall make sure their mobile phone or computer is configured for
appropriate notification (audible) upon receipt of the alert message.

Table 5 - Parameter Alerts – via SMS/WhatsApp/Email

Parameter Alert Alert Message (SMS/WhatsApp/Email)

Diastolic BP High (Based on 3rd
party device data)

(Priority) Priority Alert; Diastolic BP high in (ward x)
@13:00 Apr 23.

Diastolic BP Low (Based on 3rd
party device data)

(Priority) Priority Alert; Diastolic BP Low in (ward x)
@13:00 Apr 23.

HR High (Priority) Priority Alert; Heart Rate High in (ward x)
@13:00 Apr 23.

HR Low (Priority) Priority Alert; Heart Rate Low in (ward x)
@13:00 Apr 23.

Mean BP High (Based on 3rd party
device data)

(Priority) Priority Alert; Diastolic BP high in (ward x)
@13:00 Apr 23.

Mean BP Low (Based on 3rd party
device data)

(Priority) Priority Alert; Diastolic BP Low in (ward x)
@13:00 Apr 23.

Pulse Rate High (Based on 3rd
party device data)

(Priority) Priority Alert; Pulse Rate High in (ward x)
@13:00 Apr 23.

Pulse Rate Low (Based on 3rd party
device data)

(Priority) Priority Alert; Pulse Rate Low in (ward x)
@13:00 Apr 23.

Same Posture (Bed Sore) (Priority) Priority Alert; Same Posture (Bed Sore) in
(ward x) @13:00 Apr 23

Skin Temp High (Priority) Priority Alert; Skin Temperature High in (ward
x) @13:00 Apr 23.

Skin Temp Low (Priority) Priority Alert; Skin Temperature Low in (ward x)
@13:00 Apr 23.

SpO2%High (Based on 3rd party
device data)

(Priority) Priority Alert; SpO2% High in (ward x) @13:00
Apr 23.

SpO2% Low (Based on 3rd party
device data)

(Priority) Priority Alert; SpO2% Low in (ward x) @13:00
Apr 23.

Systolic BP High (Based on 3rd
party device data)

(Priority) Priority Alert; Systolic BP High in (ward x)
@13:00 Apr 23.

Systolic BP Low (Based on 3rd party
device data)

(Priority) Priority Alert; System BP Low in (ward x)
@13:00 Apr 23.
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Table 6 - Technical Alerts – Alert Message displayed on Active Monitoring Portal

Alert Message From Resolution

Battery Low Battery When the "Battery Low" alert message occurs, initiate "Stop
Monitoring". On completion of the Stop Monitoring pro-
cedure, replace with new Biosensor

Biosensor Dis-
connected

Biosensor Biosensor has lost connection with the Patient Relay device
or Wireless Access Point. Request patient stays within 5
meters of Patient Relay device or Wireless Access Point

Invalid HR Heart Rate System is unable to calculate Heart Rate. This may be due
to motion artefact OR outside the measurement limits.The
HR is displayed as " - - ". Make sure the Biosensor is fully
adherent to the patient’s skin.

Invalid RR Respiration System is unable to calculate Respiration Rate. This may be
due to motion artefact.

ECG Lead Off ECG Biosensor is not fully adherent to the patients skin, press the
Biosensor for 2 min. During ECG Lead off, the HR is
displayed as " - -".

Relay
Disconnected
(SPR)

Relay Relay has lost connection with Central Server. Check your
mobile phone battery charge or network connectivity.

Relay Dis-
connected
(MPR)

Relay Relay has lost connection with Central Server. Check for
power failure and network connectivity.

Relay Dis-
connected

Relay The relay bridge has lost connection with the Cloud MPR.
Check the device status and network connectivity for
troubleshooting.

Table 7 - Technical Alerts – Alert Messages via SMS/WhatsApp/Email

Parameter Alert Alert Message (SMS/WhatsApp/Email)

Battery Low When the "Battery Low" alert message occurs, initiate "Stop Mon-
itoring". On completion of the Stop Monitoring procedure, replace
with new Biosensor.

Biosensor Disconnected
(to MPR)

The Biosensor has lost connection with the Wireless Access Point in
(ward x/bed x) @13:00 Apr 23. Hours.

Biosensor Disconnected
(to SPR)

The Biosensor has lost connection with the Patient Relay device
(Relay ID) @13:00 Apr 23.
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Biosensor Disconnected
(to Relay Bridge)

The Biosensor has lost connection with the Wireless Access Point
@13:00 Apr 23. Hours.

ECG Lead Off ECG Lead Off detected for the Biosensor(Biosensor ID) @13:00 Apr
23.

Relay Disconnected
(SPR, or MPR, or Relay
Bridge)

Relay (Relay ID) has lost connection with the Central Server @13:00
Apr 23.

Notice
Alert condition delay refers to the total time from the occurrence of
triggering event (physiological value exceeding the set limits or cardiac
standstill) detected in the Biosensor to the generation of the alert signal in
the central server. User configurable independent alert condition delay for
each parameter and frequency of alert is based on acknowledgment and
priority of the alert. The delivery time of alert to the Clinician/Caregiver
mobile or computer is dependent on the internet/mobile network
connectivity.

Table 8 - Clinical Alert Generation Delay Time – Inherent

Parameters Minimum* (seconds) Maximum (seconds)

Heart Rate (Low or High) 5 11

Respiration Rate (Low or High) 30 60

Pulse Rate (Low or High) 12 24

Skin Temperature (Low or High) 300 480

Table 9 - Clinical Alert Condition Delay Time – User Selectable

Parameters Default
(seconds)

Minimum1

(seconds)
Maximum
(seconds)

Heart Rate (Low or High) 5 5 300

Respiration Rate (Low or
High)

60 30 300

1Excludes the inherent delay in alert generation as per Table 9: Clinical Alert Generation Delay Time
- Inherent.
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Skin Temperature (Low or
High)

120 20 300

Cardiac Standstill 5 5 300

Posture 2 hours 1 hour 168 hours

Systolic NA NA NA

Diastolic NA NA NA

Table 10 - Technical Alert Condition Delay Time – User Selectable

Parameters Default
(seconds)

Minimum*
(seconds)

Maximum
(seconds)

ECG Lead-off 5 5 300

Low Battery / Replace Bio-
sensor

120 15 300

Biosensor communication dis-
connection

15 15 300

Relay communication dis-
connection

15 15 300

Invalid Heart Rate 5 5 300

Invalid Respiration Rate 15 15 300

Table 11 - Parameter Alert Frequency – User Selectable

Priority Type Default Minimum Maximum Steps

High (Time) Un-Ack 5 min 5 mins 12 hours 5 min (till 60 min) & after
that 30 min

Ack 15 min

Medium
(Time)

Un-Ack 10 min

Ack 30 min

Low (Time) Un-Ack 15 min

Ack 60 min
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High (%) Un-Ack 5% 3% 100% 1%

Ack 10%

Medium (%) Un-Ack 10%

Ack 15%

Low (%) Un-Ack 15%

Ack 20%

Table 12 - Technical Alert Frequency – User Selectable

Alert Message Type Default
status

Default Minimum Maximum Steps

ECG Lead-off Un-Ack ON 5 min 5 mins 12 hours 5 min (till
60 min) &
after that
30 min

Ack 15 min

Biosensor wireless
disconnection

Un-Ack ON 5 min

Ack 30 min

Relay com-
munication dis-
connection

Un-Ack ON 5 min

Ack 30 min

Low Battery /
Replace Biosensor

Un-Ack ON 30 min

Ack 12 hours

Invalid HR / RR Un-Ack OFF 5 min

Ack 15 min

Notice
Alert limits must be set based on the clinical condition of the patient.
Setting the alert threshold limits to extreme values can render the alert
system useless.
There is no automatic alert threshold limit setting available. The alert
generation is based on the operator selected value or the factory
configured pre-set (default) values.
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Table 13 - Alert Threshold allowed limits

Parameters Default Pri-
ority

Default Minimum Maximum

Heart Rate High (BPM) MEDIUM 120 60 250

Low (BPM) 40 30 160

Respiration Rate High (BrPM) LOW 30 10 60

Low (BrPM) 8 6 55

SpO2 High (%) MEDIUM OFF 95 100

Low (%) 90 70 95

Pulse Rate High (/min) LOW 120 60 250

Low (/min) 40 30 120

Skin Temperature High (°C) LOW 38.0 20.0 43.0

Low (°C) 31.0 15.0 33.0

Systolic Pressure High
(mmHg)

LOW 160 75 240

Low
(mmHg)

90 35 150

Diastolic Pressure High
(mmHg)

LOW 90 50 180

Low
(mmHg)

50 15 50

Posture LOW Lying down
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10 Regulatory

10.1 Standards used in design, development, labelling, and
testing

Table 14 - Standards used in design, development, labelling, and testing

Description

ANSI AAMI ES 60601-1:2005 (R) (Cons. Text) [Incl. AMD2:2021] /2012, EN 60601-1 2006
/A1:2013, IEC 60601-1 :2005 /A1 2012 +AMD2:2020 , IS 13450: Part 1: 2018

ANSI AAMI IEC 60601-1-2: 2014, EN 60601-1-2: 2015, IEC 60601-1-2: 2014+AMD1:2020, IS
13450: Part 1: SEC 2:2018

ANSI AAMI HA 60601-1-11:2015, EN 60601-1- 11:2010, IEC 6061-1-11:2015+AMD1:2020, IS
13450: Part 1: SEC 11 :2020

IEC 60601-1-6:2013 (ed 3.1) +AMD2:2020, EN 60601-1-6: 2010 or ANSI AAMI IEC 62366-
1:2015+AMD1:2020, IEC 62366:2008, IEC 62366- 1:2015+AMD1:2020, IS 13450: Part 1: Sec
6: 2020

IEC 60601-1-8:2006+AMD2020; BS EN 60601-1- 8:2007+ A2:2021

IEC 60601-1-9:2020; BS EN 60601-1- 9:2008+A2:2020

IEC 60601-2-49 ; IS 13450-2-49

ANSI AAMI IEC 60601-2-47:2012 (R2016), EN 60601-2-47:2001, IEC 60601-2-47 :2012, IS
13450: Part 2: Sec 47: 2018

ANSI AAMI ISO 60601-2-25:2011(R2016), IEC 60601-2-25: 2011, EN 60601-2-
25:1995/A1:1999, IS 13450: Part 2: Sec 25: 2018

ANSI/AAMI/IEC 60601-2-27:2011/(R)2016, IEC 60601-2-27: 2011, IS 13450: Part 2: Sec 27:
2018

ISO 80601-2-61:2017; EN ISO 80601-2-61:2019; IS/ISO 80601: Part 2: Sec 61: 2011

ISO 80601-2-56:2017; IS/ISO 80601-2-56: 2017

IEEE ISO 11073-10404, 10406, 10408, 10441, 40101, 40102

ISO 10993-1:2018; ISO 10993-5:2009; ISO 10993-10:2021

AAMI ANSI EC12 2000 (R) / 2012

FCC CFR47 Part 15 subpart C

ETSI EN 300 328 V2.2.2

ETSI EN 301 489-17 V2.2.3

IEC 62304:2015

10 Regulatory

UbiqVueTM 1AXWireless Patient Monitoring System| User Manual 62 of 77



63 of 77 UbiqVueTM 1AXWireless Patient Monitoring System| User Manual

ANSI AAMI ISO 14971:2019 / EN ISO 14971:2019/A11:2021

ANSI C63.27: 2017 American National standard for Evaluation of wireless coexistence

IEC 60086-4:2019 Primary batteries - Part 4: Safety of lithium batteries

ASTM D4169 - Standard Practice for Performance Testing of Shipping Containers and Sys-
tems

ISO 15223-1: 2021 Medical devices - Symbols to be used with medical device labels, labelling
and information to be supplied - Part 1: General requirements

ASTM E1112-00: Electronic Thermometer – Intermittent – Patient temperature

IEC 82304-1 :2016 Health Software – Product requirements for Safety

MIL-STD-810H-CHG-1 (Temperature & Humidity Cycling, Thermal Shock & Vibration)

ASTM F2761-09 Essential Safety Requirements For Equipment Comprising The Patient-
Centric Integrated Clinical Environment (ICE) - Part 1: General Requirements And Conceptual
Model

ANSI/CAN/UL 2900-1:2020

ANSI/CAN/UL 2900-2-1:2020

IEC 80001-1:2021; BS EN IEC 80001-1:2021; ANSI/AAMI/IEC 80001-1:2010

IEC TR 80001-2-2:2012; ANSI/AAMI/IEC TIR80001-2-2:2012

IEC TR 80001-2-5:2014; ANSI/AAMI/IEC TIR80001-2-5:2014

ISO 20417:2021; EN ISO 20417:2021

Restriction of Hazardous Substances Directive 2011/65/EU AMD 2015/863

Registration, Evaluation, Authorisation and Restriction of Chemicals

10.2 EMC compliance and warning statement
IEC 60601-1-2: 2014

UbiqVue™ 1AXWearable Biosensor has been tested and found to comply with the limits
for a Class B digital device, pursuant to part 15 of the FCC Rules and with the limits of
the standard for medical devices, ANSI/AAMI/IEC 60601-1-2:2014 and ANSI/AAMI/IEC
60601-2-47:2012 202.6.1.1 & 202.6.2.3 suitable for use in all environment including
domestic. The unit also complies with the requirements of EN 60601-1-2:2015, providing
the presumption of compliance to the European Union’s Medical Device Directive
2007/42/EC. The limits are designed to provide reasonable protection against harmful
interference in a typical medical installation.

This equipment generates, uses radio-frequency energy for its functions. Use of this
equipment adjacent to or stacked with other equipment should be avoided because it
could result in improper operation. Portable RF communications equipment (including
peripherals such as antenna cables and external antennas) should be used no closer
than 30 cm (12 inches) to LifeSignals 1AXWearable Biosensor. Otherwise, it could
result in degradation in the performance of the equipment.
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FCC Statement (FCC ID : 2AHV9-UB2550)

This device complies with Part 15 of the FCC rules. Operation is subject to the following
conditions:

• This device may not cause harmful interference.
• This device must accept any interference received including interference that may

cause undesired operation of this device.

Any changes or modifications not expressly approved by the party responsible for
Compliance could void the user’s authority to operate the equipment. Biosensor radiator
(Antenna) is at 12.8mm away from the body and hence, exempted from SAR
measurement. Affix the Biosensor on the body as instructed in this manual for
maintaining the separation distance.

10.3 Guidance and manufacturer’s declaration – elec-
tromagnetic emissions

Table 15 - Guidance and manufacturer’s declaration – electromagnetic emissions

The Biosensor is intended for use in the electromagnetic environment specified
below. The customer or the user of the Biosensor should assure that it is used in

such an environment.

Emissions test Compliance Electromagnetic environment – guidance

RF emissions
CISPR 11 / EN5501

Group 1 LifeSignals Biosensor uses RF energy only for its
internal functions. RF emissions are very low and are
not likely to cause any interference in nearby
electronic equipment.

RF emissions
CISPR 11 /EN5501

Class B LifeSignals Biosensor is suitable for use in all
establishments, including domestic establishments
and those directly connected to the public low-
voltage power supply network which supplies
buildings used for domestic purposes.

Harmonic emissions
EN 61000-3-2

Not Applicable

Voltage
fluctuations/flicker
emissions EN 61000-
3-3

Not Applicable
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10.4 Guidance and manufacturer’s declaration – elec-
tromagnetic immunity

Table 16 - Guidance and manufacturer’s declaration – electromagnetic immunity

LifeSignals Biosensor is tested for conformance to meet the following intended for
use in the electromagnetic environment specified below. The customer or the user

of the Biosensor should assure that it is used in such an environment.

Immunity test IEC 60601
test level

Compliance
level

Electromagnetic environment -
guidance

Electrostatic
discharge (ESD)
IEC 61000-4-2

± 8 kV contact
± 15 kV air

± 8 kV contact
± 15 kV air

Floors should be of wood, concrete
or ceramic tiles. If the floor is tiled
with synthetic material the relative
humidity should be at least 30%.

Power frequency
magnetic field
IEC 61000-4-8

30 A/m 30 A/m Power frequency magnetic fields
should be that of a typical domestic
environment.

Radiated RF
EN 61000-4-3

10 V/m
80 MHz to 2.7
GHz
80% AM, 1 KHz

10 V/m
80 MHz to 2.7
GHz
80% AM, 1 KHz

Home Healthcare environment.

The Biosensor is also tested for immunity to proximity to wireless communication
equipment as per Table 9 of IEC 60601-1-2 using the test methods specified in IEC
61000-4-3.

The Biosensor is intended for use in an electromagnetic environment in which radiated RF
disturbances are controlled. The customer or the user of the Biosensor can help prevent
electromagnetic interference by maintaining a minimum distance between the portable and the
mobile RF communications equipment (transmitters) and the Biosensor as recommended
below, according to the maximum output power of the communications equipment.

Rated
maximum
output power
oftransmitter
(Watts)

Separation distance according to the
frequency of transmitter (Meters)

150 kHz to 80 MHz 80 MHz to 800 MHz 800 MHz to 2.7
GHz

10V/m 10V/m 10V/m

0.01 0.04 0.04 0.08

0.1 0.11 0.11 0.22

1 0.35 0.35 0.70

10 1.11 1.11 2.22
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100 3.50 3.50 7.00

For transmitters rated at a maximum output power not listed above, the recommended
separation distance d in meters (m) can be estimated using the equation applicable to the
frequency of the transmitter, where P is the maximum output power rating of the transmitter in
watts (W) according to the transmitter manufacture.

NOTE 1: At 80 Hz and 800 MHz the separation distance for the frequency range applies.
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is
affected by absorptions and reflections from structures, objects and people.

10.5 EMC guidance
In accordance with Clause 4.3 of IEC 60601-1, the Essential Performance of UbiqVue
1AXWireless Patient Monitoring System is:

• Data loss between the Biosensor and the Single Patient Relay shall be less than
0.035%.

• There shall not be noise exceeding 50 uV p-v on ECG signal over any 10 second
period continuously

Caution
RF emitting devices such as diathermy, electrocautery, radio frequency
identification (RFID), security systems (e.g., electromagnetic anti-theft
systems, and metal detectors) may affect essential performance. These
sources of electromagnetic energy should be avoided when using the
Biosensor. In case of potential exposure to such equipments, the user is
recommended to correct the interference by one or more of the following
measures:
• Reorient the Biosensor away from these equipments (behind the

patient body).
• Increase the separation between the Biosensor and the equipment.
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10.6 Symbols

Table 17 - Symbols

Label Identification Description

Caution or Warning This symbol instructs the user to consult the instructions
for warnings and safety precautions that could not be
presented on the device.

Manufacturer Legal manufacturer.

Product Disposal Dispose the Biosensor as a battery/electronic waste -
controlled by the local regulations.

NNNNN GUDID (Level 0)
and Serial No.

On the PCBA – Level 0 – GUDID in data matrix format
and Serial number in human readable format.

XXXXX GUDID (Level 0)
and Pairing ID

On the Biosensor – Level 0 – GUDID in data matrix
format and Pairing ID in human readable format.

GUDID (Level 1,2
and 3)

Device GUDID (Level 1, 2 & 3) with manufacturing
information. – Level 1: Serial No., Level 2 & 3: Lot No.

Unique Pairing ID Unique Pairing ID.

Catalogue Number Device Catalogue number / Labeler Product number.

Quantity Number of devices in a pouch or in a multi-carton box.

Prescription only
device

To be used under prescription supervision by a medical
practitioner.

Electronic instruc-
tions for use

Indicated on a product or product packaging that rel-
evant information for use of the product is available in
electronic form rather than, or in addition to, printed
form.

Consult instructions
for use

Refer to the instruction manual.
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Label Identification Description

Temperature range Operating, storage and transportation temperature,
short and long term, in days:
• P: Duration
• n: Number
• D: Calendar days

Atmospheric
pressure limitation

Indicates the acceptable upper and lower limits of
atmospheric pressure for transport and storage.

Humidity limitation Indicates the acceptable upper and lower limits of
relative humidity for transport and storage.

Expiry Date
(YYYY-MM-DD)

Use the device in packaged condition before the expiry
date.

Manufacturing date
and country of
manufacture.

Device manufacturing date and country of manufacture.

LOT Code Manufacturing Batch or LOT code.

Applied part Defibrillation-proof, Type CF Applied Part.

Do not reuse Do not reuse; single patient use.

IP24 Ingress Protection
Rating

Protection against solid objects that are over 12.5 mm
(e.g. large tools and hands) and protection against water
splashing from any angle.

Keep dry Keep away from liquids or water or chemicals.

Max Stack Do not stack more than (n) number of boxes.
"n" indicates the number of boxes.

FCC ID Federal
Communications
Commission

Federal Communications Commission ID.

MR unsafe (black or
red circle)

Standard practice for marking medical devices and other
items for safety in the magnetic resonance environment.
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Label Identification Description

No pacemaker Contraindicated for use on patients with active
implantable medical devices including pacemakers, ICD
and LVAD.

Authorized
representative of
Country.

Authorized representative of Country XX - Country code
as per ISO 3166-1.

Importer Indicates the entity importing the medical device into the
locale.

Distributor Entity distributing the medical device into the locale.

Damaged
packaging

Do not use if the package is damaged. The Device must
also not be used if the package holding the device is
damaged.
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11 Appendix

11.1 Troubleshooting

11.1.1 Single Patient Relay

Table 18 - Notifications

Notification Explanation Resolution

AUTHENTICATION_FAILED Login with incorrect/non-exist-
ent user credentials for clinical
facility.

Enter correct login
details.

PATIENT_NOT_FOUND. Login with
incorrect/non-existent user cre-
dentials for patient login.

Login with correct
user
credentials.

OTP_invalid. Entered OTP is invalid. Enter the correct
OTP.

Connection Unsuccessful. Biosensor not found. Ensure Biosensor
is turned ON.

PATIENT_ALREADY_DISCHARGED. Entered MRN/PID of a dis-
charged patient.

Enter or generate
new MRN/PID.

ADMISSION_ID_ALREADY_EXISTS. Entered existing Admission ID. Enter correct
Admission ID.

No internet. Please check your
connection.

Internet unavailable on the relay
device.

Check with your
local internet pro-
vider.

Connection lost, check Biosensor LED
is ON and move relay(mobile) device
closer to Biosensor.

Biosensor is out of 5 meters
radius of relay device.

Move the Bio-
sensor closer to
the relay device.

Biosensor battery level is low. Battery <15% Consider replacing
the
Biosensor.

Retrieving Biosensor Information l
Transferring to Hospital Network l Was
reconfiguration successful? l Are you
sure the Biosensor has Transferred? l
Transfer in progress.

Sequence of messages which
appear following Transfer to
Hospital request.

Check whether the
Biosensor has
transferred.
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Lead OFF. Check Biosensor
adherence to skin and retry.

Biosensor has detached from
the skin.

Press the entire
Biosensor for two
minutes.

Server connection failed. Server unavailable. Please contact
your service
provide.

Unable to transfer Biosensor to
hospital network.

Failed the transfer
process.

Try to transfer to
the hospital net-
work again.

BP device in use. Unassign from pre-
vious patient or enter another device ID.

The BP device that is attempt-
ing to connect is already linked
to another patient.

Remove it from the
previous patient
profile or use
another device.

SPO2 device in use. Unassign from pre-
vious patient or enter another device ID.

The SPO2 device that is
attempting to connect is already
linked to another patient.

Remove it from the
previous patient
profile or use
another device.

Finger Out! The finger is removed from the
SPO2 probes.

When recording
the
measurements,
ensure the
finger is properly
positioned.

Device not found. Third-Party device not found or
device is turned off.

Turn on the device
or move closer to
the mobile.

Invalid server ID When the user tries to login with
invalid server id or enters incor-
rect spelling in the server id. It
does not connect to the server.

Enter the correct
Server ID.

11.1.2 Active Monitoring Portal

Table 19 - Notifications

Notification Explanation Resolution

Auto Generate Patient ID
is Disabled. Please
enable the Settings to
AutoGenerate the ID

Autogeneration of new MRN/ID
has been disabled by admin-
istrator

Contact CFA.

Biosensor already in use The Biosensor is already
assigned to some other patient.

Enter the new Biosensor ID.
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Device is already in use. Attempting to assign Third party
device which is currently in use
by another patient

Select different device.

Error! Group Name
Already Exists.

This group name has been
added

Add new group name.

**Error! Logo height
exceeds the width

Height exceeds the width for co-
branding logo

Select image with correct height
and width ratio.

**Error! Logo should be at
least 48x48 px

Image too small for co-branding
logo.

Select image with minimum 48 x
48 pixels..

**Error! Logo should be
within 800x512 px

Image too large for co-branding
logo

Select image with maximum 800
x 512 pixels.

Error! More than one Bio-
sensor streaming

Attempting to assign two stream-
ing Biosensors to a single
patient

Assign patient to the correct Bio-
sensor.

Error! Previous Admission
is not Discharged

Attempting to admit existing
patient with new admission ID

Discharge patient, then admit
the patient.

**File size exceeds max-
imum size limit of 2 MB

File size too large for co-brand-
ing logo

Select file size <2 MB.

**Invalid File Format.
Please select an image
file

Selected invalid file format for
co-branding logo

Select image file with correct
format e.g. gif,jpeg,png,s-
vg,webp.

Operation Failed Attempt to reset/save password
from profile page unsuccessful.

Try to reset/save password
again.If unsuccessful,contact
the administrator.

Patient Already Dis-
charged. Replace Patient
ID.

Attempting to readmit a patient
using previous the Patient ID.

Enter the new Patient ID for the
patient. .

Password Reset Failed Attempt to reset password
unsuccessful

Request password reset again.
If unsuccessful, contact the
CFA.

Something went wrong.
Please try again !

Attempt to relay the Biosensor
data via hospital network/mobile
relay unsuccessful. (not con-
necting to access point).

Try to relay the Biosensor data
via hospital network/mobile
again. If unsucessful, contact
the administrator.

Something went wrong.
Please try again !

Attempt to save Event/Note
unsuccessful

Try to save Event/Note again. If
unsuccessful, contact the admin-
istrator.

USER ALREADY EXISTS
WITH THIS
EMAIL/PHONE
NUMBER!!

This user's email/phone number
is already in the system

Enter new email/phone number
for the user.
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11.1.3 Frequently Asked Questions

Wireless Communication Failure Queries

Why is "Biosensor Disconnected" being displayed in
the Active Monitoring Portal?

This could be attributed to a wireless
communication failure between the Bio-
sensor and the access point.

Reasons: 1) Patient walks out of the net-
work area.
2) Access point gets switched off.

Effects: Access to real time/streaming
data will be discontinued. The data will
resume streaming upon reconnection to
the network. Ensure that the patient is
within 5-meter radius of the Access
point. Verify the functionality of the
access point.

Contact Technical Team for further
assistance.

Why is the LED blinking fast in green? This could be attributed to a wireless
communication failure between the Bio-
sensor and the Access Point.

Reasons: 1) Patient walks out of the net-
work area. 2) Access point gets
switched off.

Effects: Access to real time/streaming
data will be discontinued. The data will
resume streaming upon reconnection to
the network. Ensure that the patient is
within a 5-meter radius of the Access
point and the Biosensor - LED is blink-
ing slow (green) (once in every 3 secs).
Verify the functionality of the access
point.
Contact technical team for further
assistance.
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Why is "Relay Disconnected" being displayed? This could be attributed to a wire-
less/wired network failure between the
Relay device and the Central server.
> Single Patient Relay(SPR) - Relay
has lost connection with the Central
Server. Make sure the mobile phone
has enough battery charge and the net-
work/internet connectivity is good. Make
sure the Flight mode is OFF. Make sure
the App is not stopped forcefully.

> Multi Patient Relay(MPR) - The
Relay has lost connection with the Cen-
tral Server. Check for power failure and
network/internet connectivity. (Contact
Technical Team for assistance).

>Relay Bridge -The Relay has lost con-
nection with the Central Server. Check
for network/ internet connectivity.

If the “Biosensor is disconnected” due to wireless
communication error, can we still view the data?

Live data will not be available. However,
the missing data will be stored in the
central server. The data recorded prior
to Biosensor disconnection will be
accessible.

If the “Relay is disconnected” due to wireless com-
munication error, can we still view the data in the
trend?

The data recorded prior to the relay dis-
onnection will be available in the trend.

What if the Beep sound is heard from the mobile
(SPR) ?

It could be due to the wireless com-
munication failure between the Bio-
sensor and the SPR.

What to do when the mobile App (SPR) shows "No
internet, please check your connection"?

It could be due to mobile coverage issue
or wrong setting like Airplane mode ON
or inadequate bandwidth.

11.2 Document References
1. DHF09-LBL-005 UbiqVue™ HDO Network Configuration Manual.
2. DHF09-LBL-004 UbiqVue™ MPR Installation & Configuration Manual.
3. DHF09-LBL-007 UbiqVue™ Relay Bridge Installation & Configuration Manual
4. DHF09-LBL-008 UbiqVue™ SPR Installation & Configuration Manual.
5. DHF09-LBL-010 UbiqVue™ Central Server Installation & Configuration Manual.
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11.3 Third Party Devices

Name of the Medical Device Manufacturer Model Number

BP Monitor Omron HEM7600T-AP3

SpO2Watch Contec CMS50F

11.4 Cloud Infrastructure
LifeSignals, Inc. uses Amazon Web Services (AWS) for its Central Server and
ActiveMonitoring Portal and Infrastructure. LifeSignals AWS Infrastructure primarily uses
two EC2 Servers which are in the same availability zone.The LifeSignals' Monitoring
team monitors the performance of the Central Server and the Active Monitoring Portal
24/7 using New Relic and CloudWatch Alarms for anydowntime or service disruptions. In
case of any alerts, the team will try to solve the issue as per the Runbook and create
Root Cause Analysis.

Amazon Web Services - Service Level Agreement (SLA)

• Region-LevelSLA
For Amazon EC2 with all running instances deployed concurrently across two or
more availability zones in the same region (or at least two regions if there is only
one availability zone in a given region), AWS will use commercially reasonable
efforts to make Amazon EC2 available for each AWS region with a Monthly Uptime
Percentage of at least 99.99%.

• Instance -Level SLA
For each individual Amazon EC2 instance (“Single EC2 Instance”), AWS will use
commercially reasonable efforts to make the Single EC2 Instance available with an
Instance-Level Uptime Percentage of at least 99.5% in each case during any
monthly billing cycle (“Instance-Level SLA”).

Ref: https://aws.amazon.com/compute/sla/

Disaster Recovery Plans

• Hourly Backups are taken in the form of AWS AMI.
• In case of AWS availability zone failure, LifeSignals shall launch the EC2 server from

the latest AMI in another availability zone and attach Elastic IP to continue the
operations. The SLA for this operation is 1-2 hours.

• In case of a Regional failure for AWS, LifeSignals shall use an hourly AMI taken from
the last region of failure and to be restored on the new EC2 server launched in
another region. The SLA for this operation is 2-3 hours.
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Note: Availability Zones are distinct locations within an AWS Region that are engineered
to be isolated from failures in other availability Zones.

Impact on AWS Outage

• Central Server and Active Monitoring Portal shall be inaccessible during the AWS
outage.

• If Regional/Availability zone outage occurs, the users may lose up to one hour of
data (i.e. AMI Snapshots are taken on an hourly basis).

11 Appendix

UbiqVueTM 1AXWireless Patient Monitoring System| User Manual 76 of 77



77 of 77 UbiqVueTM 1AXWireless Patient Monitoring System| User Manual

For printed copies, contact by mail or phone. (Refer Page ii).
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